
®

SAVE THIS MANUAL FOR FUTURE REFERENCE

Owner’s Manual
Power Zone® Gateway
for use with Power Zone 410



ii Owner’s Manual for Power Zone Gateway on PZ 410

(000393a)

WARNING
CANCER AND REPRODUCTIVE HARM

www.P65Warnings.ca.gov.



Owner’s Manual for Power Zone Gateway on PZ 410 iii

Table of Contents
Section 1: Introduction and Safety
Introduction ..........................................................1

Read This Manual Thoroughly ....................................1

Safety Rules .........................................................1
General Hazards .........................................................2
Electrical Hazards .......................................................2

Section 2: General Information
Equipment Description .......................................3
Symbol Definition ................................................3
Standard Features ...............................................3
Codes and Standards ..........................................3
Specifications ......................................................4
Connection Locations .........................................5
Dimensions ..........................................................6

Section 3: Installation and Operation
Cleaning ................................................................7
Connection Details ..............................................7
Light Emitting Diodes (LEDs) .............................7
Connecting to the Gateway ................................7

Ethernet Connection ....................................................7

Home Screen ........................................................8
Screen Layout ......................................................8

Top Banner ..................................................................9
Bottom Banner ..........................................................10
Home Screen Bargraphs ...........................................11
Alarm Ribbon .............................................................11

Screen Features .................................................11
Scrolling .....................................................................11
Language ..................................................................12
Units of Measure .......................................................12
Date/Time ..................................................................12
Health Checkmark .....................................................12
Editing .......................................................................13

Screen Icon Details ............................................14
Home Screen ............................................................14
Engine Detail Screen .................................................14
Alternator Detail Screen ............................................14
System Detail Menu ..................................................15
Setup Menu ...............................................................16

Calendars ........................................................... 17
Set Date/Time ...........................................................17

Communications ............................................... 17
Ethernet Port Setup ...................................................18
External Interfaces ....................................................18
IP Whitelisting ............................................................25
Email .........................................................................26
Configuring Modbus Pass Through ...........................26

Tools Menu ........................................................ 27
Login Menu ........................................................ 27
Help ..................................................................... 29

About Screen .............................................................29
Upload Documents Screen .......................................29

Login and Security ............................................ 29
Transfer Switch Dashboard .............................. 30

Section 4: Troubleshooting
Troubleshooting Guide ..................................... 31



iv Owner’s Manual for Power Zone Gateway on PZ 410

This page intentionally left blank.



Owner’s Manual for Power Zone Gateway on PZ 410 1

Introduction and Safety

Section 1: Introduction and Safety
Introduction
Thank you for purchasing a Generac Power Systems,
Inc. product. This unit has been designed to provide high
performance, efficient operation and years of use when
maintained properly.
The information in this manual is accurate based on
products produced at the time of publication. The manu-
facturer reserves the right to make technical updates,
corrections, and product revisions at any time without
notice.

Read This Manual Thoroughly

If any section of this manual is not understood, contact
the nearest Independent Authorized Service Dealer
(IASD) or Generac Customer Service at 1-888-436-3722
(1-888-GENERAC), or visit www.generac.com for start-
ing, operating, and servicing procedures. The owner is
responsible for correct maintenance and safe use of the
unit.
This manual must be used in conjunction with all other
supporting product documentation supplied with the
product.
SAVE THESE INSTRUCTIONS for future reference. This
manual contains important instructions that must be fol-
lowed during placement, operation, and maintenance of
the unit and its components. Always supply this manual
to any individual that will use this unit, and instruct them
on how to correctly start, operate, and stop the unit in
case of emergency.

Safety Rules
The manufacturer cannot anticipate every possible
circumstance that might involve a hazard. The alerts in
this manual, and on tags and decals affixed to the unit,
are not all inclusive. If using a procedure, work method,
or operating technique that the manufacturer does not
specifically recommend, verify that it is safe for others
and does not render the equipment unsafe.
Throughout this publication, and on tags and decals
affixed to the unit, DANGER, WARNING, CAUTION, and
NOTE blocks are used to alert personnel to special
instructions about a particular operation that may be
hazardous if performed incorrectly or carelessly. Observe
them carefully. Alert definitions are as follows:

NOTE: Notes contain additional information important to 
a procedure and will be found within the regular text of 
this manual.

These safety alerts cannot eliminate the hazards that
they indicate. Common sense and strict compliance with
the special instructions while performing the action or
service are essential to preventing accidents.
The operator is responsible for proper and safe use 
of the equipment. The manufacturer strongly 
recommends that if the operator is also the owner, to 
read the owner’s manual and thoroughly understand 
all instructions before using this equipment. The 
manufacturer also strongly recommends instructing 
other users on how to properly start and operate the 
unit. This prepares them if they need to operate the 
equipment in an emergency.

(000100a)

Consult Manual. Read and understand manual
completely before using product. Failure to 
completely understand manual and product 
could result in death or serious injury.

WARNING

(000001)

DANGER
Indicates a hazardous situation which, if not avoided, 
will result in death or serious injury.

(000002)

WARNING
Indicates a hazardous situation which, if not avoided,
could result in death or serious injury.

(000003)

CAUTION
Indicates a hazardous situation which, if not avoided,
could result in minor or moderate injury.

www.generac.com
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General Hazards

Electrical Hazards

(000182a)

WARNING
Equipment damage. Only qualified service personnel may 
install, operate, and maintain this equipment. Failure to 
follow proper installation requirements could result in death, 
serious injury, and equipment or property damage.

(000144)

DANGER
Electrocution. Contact with bare wires, 
terminals, and connections while generator 
is running will result in death or serious injury.

(000152)

DANGER
Electrocution. Verify electrical system is
properly grounded before applying power.
Failure to do so will result in death or serious
injury.

(000188)

DANGER
Electrocution. Do not wear jewelry while 
working on this equipment. Doing so will 
result in death or serious injury.

(000104)

DANGER
Electrocution. Water contact with a power 
source, if not avoided, will result in death 
or serious injury.

(000145)

DANGER
Electrocution. In the event of electrical accident, 
immediately shut power OFF. Use non-conductive 
implements to free victim from live conductor. Apply 
first aid and get medical help. Failure to do so will 
result in death or serious injury.

(000187)

WARNING
Electrocution. Potentially lethal voltages are generated
by this equipment. Render the equipment safe before
attempting repairs or maintenance. Failure to do so
could result in death or serious injury.

WARNING
Electrocution. More than one live high voltage 
circuit is present. Disconnect all power 
sources before servicing. Failure to do so 
could result in death or serious injury. (000563)

(000155a)

WARNING
Electric shock. Only a trained and licensed electrician 
should perform wiring and connections to unit. Failure to 
follow proper installation requirements could result in death, 
serious injury, and equipment or property damage.
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General Information

Section 2: General Information
Equipment Description
The Generac Power Zone Gateway (Assembly No.
A0002163973) is a user interface for the Power Zone
system. The Gateway can be used in applications other
than generator control.

Symbol Definition

Standard Features
• AUTO/OFF/MANUAL Indication
• Not in AUTO Indication
• Alarm Acknowledge Button
• Multi-Lingual
• On Screen Editable Parameters
• Key Function Monitoring

– Three Phase Voltage, Amperage, kW, kVA, 
and kVAR

– Voltage Frequency
– Engine Speed
– Engine Coolant Temperature
– Engine Oil Pressure
– Engine Oil Temperature
– Battery Voltage
– Warning and Alarm Indication
– Maintenance Events/Information
– Engine Hourmeter

Codes and Standards
• UL 2200
• ANSI/CAN/ULC 6200: ETL approval
• CE Mark
• RoHS Compliant

AC Generator

AC Voltage

DC Voltage

G
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Specifications

NOTE: The Ethernet, RS-485, and USB cables should not be run in the same conduit or in the same wire grouping as
any high voltage or high current conductors.
NOTE: The RS-485 settings such as baud rate should be selected to be compatible with other components that are
connected to the RS-485 bus.

Environmental Specifications
Operating Temperature -40 °F (-40 °C) to 140 °F (60 °C)
Humidity 5% to 90% non-condensing
Enclosure UL Type IP2X
Weight 0.5 lbs
Power Supply Requirements
Power Supply Voltage 7 to 35 V  (12 / 24 V  nominal)
Power Supply Usage 0.5 A (maximum during power up)
Power Supply Cable 2 wires - 16 AWG recommended
Communication (Ethernet)
Number of Ports 1
Communication Link 4 wires minimum of 8 pin connector - 2 wire Receive and 2 wire Transmit
Communication Cable Cat5e – 2 twisted pairs
Maximum Cable Length 328 ft (100 m)
Baud Rate Auto-Detect 10/100 Mbps
Communication (RS-485)
Number of Ports 2
Communication Link 2 wires
Communication Cable 3 wires - shielded twisted pair and ground
Maximum Cable Length 4,000 ft (1,219 m)
Baud Rate Up to 115.2 kbps
Maximum Number of Devices 32
Protocol/Device Type Modbus / 1 Master and 1 Slave
Communication (USB)
Number of Ports 2
Connector Type A
USB version USB 1.1/2.0
Maximum Cable Length 16.5 ft (5 m)
Baud Rate 12 Mbps, 480 Mbps
LED
Number of LEDs 2
Color Red and green
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Connection Locations

Figure 2-1. Connection Locations (Bottom View)

NOTE: See Connection Details for more information regarding the connections and LEDs.

A Communication LED (Green) D Power and RS-485 Connec-
tor (Gen. Controller) G USB 1 Connection

B Power LED (Red) E Aux RS-232 Port H USB 2 Connection

C Aux RS-485 Port F Ethernet Connection I Aux Power Connection 
(Common with D)

B

013864

D C

A

EFGHI
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Dimensions

Figure 2-2. Gateway Enclosure Dimensions

A 5.39 in (136.8 mm) D 2.0 in (51 mm)

B 2.89 in (73.3 mm) E 5.87 in (149 mm)

C 3.36 in (85.5 mm)

A

B C

013866

013865

D

E
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Section 3: Installation and Operation
Cleaning
Do not use any cleaning solution to clean the Gateway
enclosure or cover. Clean with a damp cloth or sponge.
The Gateway contains electronic circuitry. Use extra cau-
tion not to drip water inside the Gateway. If water or other
liquid enters the Gateway, disconnect power until com-
pletely dry.

Connection Details

Light Emitting Diodes (LEDs)
There are two LEDs at the front on the enclosure:

• Red LED: Represents system power. 
– If red LED is on, Gateway is powered. 
– If red LED is off, Gateway is not powered.

• Green LED: Represents RS-485 (only) communi-
cation status.
– If green LED is blinking, RS-485 communication 

is working properly. The blinking rate will be 0.25 
seconds on and 0.25 seconds off (2 Hz).

– If green LED is off, RS-485 communication is not 
working properly or RS-485 interface is not con-
nected.

Connecting to the Gateway
The Gateway can be accessed via Ethernet.

Ethernet Connection
1. To connect via Ethernet, the Ethernet IP Address is

required. This information can be accessed via the
Power Zone 410’s Display. See Technical Manual
Power Zone Controller for further details.

NOTE: The IP address and subnet mask on your PC's
Ethernet port must be set to a fixed IP address in the
same subnet range as the IP address of the Gateway.

2. Connect Ethernet cable from the Gateway to the
PC.

3. Open a web browser (Google Chrome™ preferred)
and enter the Ethernet IP address in the top bar of
the browser. After a few minutes, the web browser
should display the Generac app.

(000182a)

WARNING
Equipment damage. Only qualified service personnel may 
install, operate, and maintain this equipment. Failure to 
follow proper installation requirements could result in death, 
serious injury, and equipment or property damage.

Connector Description Purpose Wire # (Default)

PWR_RS485-5 12 V Provides power to the 
Gateway

15F

PWR_RS485-4 Ground 0C

PWR_RS485-3 RS-485 Ground This is Modbus Master and is 
used to connect to Power 
Zone 410 Controller

0B

PWR_RS485-2 RS-485 - 393

PWR_RS485-1 RS-485 + 392

Ethernet RJ-45 Ethernet connector Used to connect to PC, BMS, 
or other external device –

USB Universal Serial Bus Type A 
connector

Can be used for external add 
on USB devices or modules –
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Home Screen
See Figure 3-1. This screen displays bar graphs for the
most common measurements, and an overall health
check for the generator. The number of displayed mea-
surements will change depending on whether or not the
generator is running.

Figure 3-1. Home

Screen Layout
See Figure 3-2. The screen is divided into the Top Ban-
ner (A), the Bottom Banner (B), and the main screen
information area in the center (C). The top and bottom
banners are displayed on every screen.

Figure 3-2. Screen Layout

014621

A

C

B

014621
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Top Banner

Figure 3-3. Top Banner Features

(A) Keyswitch Status
A red LED indicates the key is in the OFF position. A
green LED indicates the key is in the AUTOMATIC posi-
tion. An orange LED indicates the key is in the MANUAL
position.

(B) Communications Health
A blinking green LED indicates the controller is respond-
ing to Modbus requests. A blinking red LED indicates the
Main Controller is not responding to requests.

(C) Generator Name
Displays the name of the generator. The user can give
the generator an easy to understand name such as
“East”, “West”, or “Number 1”. See Figure 3-4. To name
the generator, go to Setup → Communications → Device
Manager screen, press the Edit button (E) and enter the
Friendly Name.

(D) Run Hours
Displays the total number of hours the generator has
been run.

Figure 3-4. Edit Generator Name

A B C D

007516

014623

E
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Bottom Banner
See Figure 3-5. All of the displays and features of Power Zone are accessed via a nested menu system. Navigation is
performed by selecting the relevant icon at the bottom of the screen. The icons are always visible and include a BACK
icon to navigate back to the top layer. Hovering the mouse over the icon will display a “tool tip” above the icon describ-
ing its function.

Figure 3-5. Bottom Banner Features

(A) Dashboard
This icon displays bargraphs for the most common
system information and provides access to the following
submenus:

– ON/OFF Status
– Current alarms and warnings
– Maintenance Notes
– TX status

(B) Engine
This icon provides access to the bargraphs showing
engine related information. The submenu allows editing
of engine related configuration parameters.

(C) Alternator
This icon provides access to the bargraphs showing
alternator related information. The submenu allows
editing of alternator related configuration parameters.

(D) System
This icon provides access to information such as alarm
history, system notes, dealer information, and nameplate
data.

(E) Setup
This icon provides access to the setup submenu. The
setup submenus allow editing for language and units
selection, system setup, AMF, enabling alarms, date/time
setting, exercise setup, and communications setup.

(F) Tools
This icon provides access to items for configuration file
transfer, firmware updates, https configuration, and
modbus reads.

(G) Help
This icon provides access to manuals, tips, and
Frequently Asked Questions (FAQs).

(H) Home
This icon provides access to bargraphs for the most com-
mon measurements and an overall health check for the
generator. The displayed measurements change
depending on whether or not the generator is running.

(J) Back
This icon takes the user back to the previous screen.

015128

HA B C D E F G J
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Home Screen Bargraphs
See Figure 3-6. The center of the screen contains data in
the form of bargraphs. The color of the bar changes to
yellow once the measurement triggers a warning (either
high or low). The color of the bar changes to red once the
measurement triggers an alarm. If a measured value
exceeds the bargraph range, the bargraph is outlined in
red.

Figure 3-6. Bargraph

Alarm Ribbon
See Figure 3-7. This area is hidden when there are no
alarms or warnings. If an alarm or warning condition
occurs, a “Ribbon” will be drawn across the lower portion
of the screen showing the condition. Select the icon that
appears to initiate a different action for each icon, as
shown below.

NOTE: The “Check Engine” icon is displayed only for
emissions related Diagnostic Trouble Codes (DTCs).
Normally, these DTCs cannot be cleared manually. They
will clear when the system has met the required condi-
tions for the required length of time or number of run
cycles.

Figure 3-7. Alarm Ribbon

Screen Features

Scrolling
See Figure 3-8. Use a mouse to move the scroll bars.

Figure 3-8. Scroll Bar at Edge of Screen

IIcon Description

Alarm (Red): Displays the Alarms and 
Warnings Screen

Warning (Yellow): Displays the Alarms and 
Warnings Screen

Alarm Horn Active: Silences the alarm horn

Alarm Horn Silenced: No action

Check Engine: No action

Dealer Information: Displays the dealer 
information screen

“Not in Auto” Icon (Red): Displays the 
AUTO/OFF/MANUAL screen

%
007518

014621

007520
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Language
See Figure 3-9. The screen is designed to be multi-lin-
gual. Each remote user can have a different language
displayed without affecting the other remote users or the
Controller Built-in Display. To set the language, go to the
(E) Setup icon (on the bottom banner) choose “User” →
“Language/Locale”. A drop down box for languages will
appear on the right hand side. Select “Apply Changes” to
save the language selection. 

Figure 3-9. Language Selection

Units of Measure
See Figure 3-10. To set the units of measure go to the
(E) Setup icon (on the bottom banner) and choose
“User”. A selection for “Units of Measure” will appear on
the right side of the screen. Checking the “Save” button
will save the selection. 

Figure 3-10. Units of Measure

Date/Time
See Figure 3-11. The system date and time can be set
from the (E) Setup icon (on the bottom banner). Navigate
to Setup → Calendar → Date/Time.

Changing the date/time on the Gateway means a change
to the “System Time” and this will eventually change all
other connected equipment (displays and modules) in the
system. This will affect timestamps of data and execution
of calendar based commands.
The default time setting shown on the Gateway is set via
the date format setting on the controller built-in display.

Figure 3-11. Date / Time

Health Checkmark
See Figure 3-12. The checkmark indicates the system is
healthy. 

Figure 3-12. System is Healthy (Green)

See Figure 3-13 and Figure 3-14. When the generator
has an alarm or warning status, the checkmark will
change to indicate the level of fault.

007522

014624

014703

007524
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Figure 3-13. Shutdown Alarm Condition (Red)

Figure 3-14. Warning Condition (Yellow)

Editing
Editing of configuration parameter values is performed by
two methods: by entering a value (Figure 3-15) or
selecting a value using the pull down selection box
(Figure 3-16).

Figure 3-15. Numeric Value Editing (with ranges)

Figure 3-16. Pull Down Selection Box

007525

007526

007528

007529
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Screen Icon Details

Home Screen
This screen displays bar graphs for the most common
measurements, and an overall health check for the gen-
erator. The number of displayed measurements will
change depending on whether or not the generator is
running.

Maintenance Notes
See Figure 3-17. This screen displays an editable file of
maintenance notes. Click on the “Add” button to add
notes and click the “Submit” button. The notes will appear
below. “Routine Maintenance” has been added as shown
in Figure 3-17. The notes can be edited or deleted by
choosing the edit or delete small icons on the notes.

Figure 3-17. Maintenance Notes

Engine Detail Screen
See Figure 3-18. The Engine Detail Screen displays
bargraphs of measured engine parameters. In some
cases the readings will be empty if the associated
sensors are not fitted. The engine screen also provides a
button to access the Engine Settings screen. This screen
allows editing of engine related configuration parameters.

Figure 3-18. Engine Screen

Engine Settings
See Figure 3-19. The Engine Settings screen displays
an icon for each entry on the left side of the entry. Click
on the text field and enter a new value. The new value is
entered and saved. If the value is out of range a red

warning will display and prevent saving of data. The
range will be displayed above the keyboard entry as
shown in Figure 3-15.

Figure 3-19. Engine Settings

Alternator Detail Screen
See Figure 3-20. The Alternator Detail Screen displays
bargraphs of measured alternator parameters.The alter-
nator screen provides a button to access the Alternator
Settings screen. This screen allows editing of alternator
related configuration parameters.

Figure 3-20. Alternator Detail Screen

Alternator Settings
See Figure 3-21. The Alternator Settings screen displays
an icon for each entry on the left side of the screen. Click
on the text field on the right and enter a new value. The
new value is entered and saved. If the value is out of
range a red warning will display and prevent saving of
data. The range will be displayed above the keyboard
entry as shown in Figure 3-15.

007532

014627

014625

014626
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Figure 3-21. Alternator Settings

System Detail Menu
The System Detail menu provides access to the alarm
logs, run logs and maintenance logs, contact information,
system notes, and maintenance notes.

Alarms and Warnings
The Alarms and Warnings screen displays only active
and present alarms and warnings. 
A Warning (A) is considered active when the condition for
the warning is present. A Warning is low severity and
does not need to be acknowledged.
An Alarm (B) is considered active when an alarm condi-
tion is or was present, but the alarm has not yet been
acknowledged. An Alarm is high severity and must be
acknowledged. The generator will not operate when an
Alarm is present.
The list of active alarms and warnings is organized into
sections with controller alarms and warnings appearing
at the top of the list followed by alarms and warnings for
each transfer switch on the RS485 bus connected to the
Gateway AUX 485 port. Each section is preceded by a
row of orange text that describes the device that gener-
ated the alarm and a “Reset” button that can be used to
reset the alarms on that device. If the conditions for an
alarm or warning are still present, they will reappear as
new. 

NOTE: Resetting controller alarms can result in the 
generator starting if all other start conditions are active.

Alarms and Warnings are displayed with their respective
icons to the left followed by the word “Alarm” or “Warning”
followed by text describing the alarm.

The System Detail menu provides access to the Alarm
logs, 410 controller Run logs and Maintenance logs, TX
alarm and event logs, contact information, and system
notes and maintenance notes.

Figure 3-22. Reset Alarms, Warnings, and Maintenance

Alarm, Warning, Run, and Maintenance Logs
See Figure 3-23. The Alarm, Run, and Maintenance Log
screens show a chronological list of alarm, run and main-
tenance logs. See PZ 410 Controller Technical Manual
for list of possible alarms and warnings. Each alarm entry
is date and time stamped and shows the alarm text and
e-code of the parameter at the time it occurred. The list
filters to show alarms, warnings, run stop/starts, and
maintenance items. The list is paginated and up to 1,000
entries for each log type can be stored. 
The log exports to USB devices connected to the USB
port of the Gateway or to the default download location of
your browser. There is also an option to email the log to a
list of recipients.

Download log to USB drive:
1. Select “Export”.
2. Select “USB”. A file named “log.csv” will be saved

to the storage device attached to the USB port.
Download log to remote computer:

1. Select “Export”.
2. Select “Download”. A file will be downloaded

through your browser.
Send log using email:

NOTE: This is only available if an email server has been 
configured in the Communications Settings.

1. Select “Export”.
2. Select “Email”.
3. Enter email addresses separated by commas.
4. Select “Send”.

014628

014629

B
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Figure 3-23. Alarm History

Run Logs
See Figure 3-24. The Run Logs screen shows the
generator operation history.

Figure 3-24. Run Logs

Maintenance Schedule
See Figure 3-25. The Maintenance Schedule screen
displays maintenance items organized by type, date, and
hours.

Figure 3-25. Maintenance Schedule

Contact Information
See Figure 3-26. The Dealer Information screen is an
editable text field where dealer contact information is
stored.

Figure 3-26. Contact Information

System Notes
The System Notes screen is an editable text field where
system notes and information are stored. It is available
from the System Details screen. Click the “Add” button to
add notes, then and click the “Submit” button to save
them. The notes will appear below. The notes can be
edited or deleted by clicking the “Edit” or “Delete” icons
on the notes.

Setup Menu
The Setup menu provides access to the submenus for
user language and units selection, system setup, AMF, I/
O alarm enabling, calendars, and communications.

User (Units and Language)
The User screen allows selection of units of measure and
language. These items are covered in Units of Measure.

System Setup
See Figure 3-27. The System Setup screen is used to
enter global settings about the generator.

Figure 3-27. System Setup

Wiring type selection is for two wire start or three wire
start.
Select ‘Enable Chicago Code’ to satisfy Chicago Code
requirements. Only for use in required jurisdiction.

Auto Mains Failure (AMF)
Auto Mains Failure (AMF) provides a way to control a
non-intelligent transfer switch from the Power Zone 410
Controller. When AMF is enabled, the Controller monitors
utility voltage and frequency, controls starting, and
stopping of the generator. 

Ground Fault Indication (GFI)
The GFI feature is used to indicate when there is a higher
than desired combination of ground current and neutral
current.

015127

014635

014636

007539

014637
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Figure 3-28. Ground Fault Indication (GFI)

Calendars
See Figure 3-29. The Calendars screen displays date
and time related functions.

Figure 3-29. Calendars

Set Date/Time
This is covered in Date/Time.

Exercise Setup
See Figure 3-30. This screen is used to setup Single
generator exercise. Select how often the exercise should
run (weekly or biweekly) and which day of the week. Mul-
tiple days can be selected. Select the start week of Bi-
Weekly (this week or next week). Set Time of the Day
and Duration in 24 hour format.

Figure 3-30. Exercise Setup

Communications
The Communications screens are used to configure the
settings for the ethernet port used for connecting to an
external ethernet network, view the modules connected
on the internal Modbus RTU network through the Device
Manager, configure remote modbus access to the Gate-
way, configure SNMP,   view and configure the Gateway
Internal serial (RS-485, RS-232) interfaces, configure IP
Whitelisting, and configure Email server and configure
distribution list for receiving alarm logs.

015126

014620

014619
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Ethernet Port Setup

Static IP Address Configuration for Ethernet
1. See Figure 3-31. Navigate to (E) Setup (on the 

bottom banner) → Communications → Ethernet 
Gateway.

2. In the “Connection mode” setting, select “Static”
(A).

3. This mode is selected to assign an IP address
(IPv4) to the Ethernet interface (B).

4. IPV4 Address, Subnet, DNS, and Gateway (C) are
set to match the requirements of the host network.

5. Click “Apply Changes” (D).

Figure 3-31. Static IP Address Configuration for Ethernet

Dynamic IP Address Configuration for Ethernet
1. See Figure 3-32. Navigate to: Setup →

Communications → Ethernet
2. Click Ethernet interface (A).
3. In the “Connection mode” setting, select “Dynamic”

(B). This mode is selected to obtain an IP address
via DHCP.

4. Click “Apply Changes” (C).
5. Once an IP address has been assigned, the IPV4

address and MAC address of the interface is
displayed.

Figure 3-32. Dynamic IP Address Configuration for 
Ethernet

External Interfaces

Figure 3-33. Status of External Interfaces

Select ‘Communications’ -> ‘External Interfaces’ view a
consolidated status of the service status for each of the
external interfaces, as shown in Figure 3-33 ‘Status of
External Interfaces’. Clicking on ‘Configure’ for the corre-
sponding interface will present a window for adjusting the
settings. The table below shows the services that can be
configured for each of the interfaces:

013986

A

B

D

C

Port Services

Ethernet Built In Modbus Gateway, SNMP

RS485 Built In Disabled, Modbus Master, Modbus 
Gateway

RS232 Built In Disabled, Modbus Master, Modbus 
Gateway

A

013987

B

C

014868
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Configuring Modbus Gateway (Pass Through)
The Power Zone Gateway acts as a gateway for external
systems to exchange data with a Power Zone System
using Modbus. The Gateway supports both Modbus TCP
and Modbus RTU over RS-485 or RS-232. 
To enable Modbus TCP access, the Ethernet Built In
interface is configured. 

1. Press under 'Ethernet Built In' Configure button ->
Modbus Gateway Configure button.

2. Selected the 'Enable' check box (F).
3. At a minimum, configure settings Unit ID (A),

Ignore Unit ID (G), and Read-only (B). 
4. See Secure Modbus Gateway for description for

configuring secure access.
To enable RS-485 / RS-232 Modbus RTU access, the
RS-485 / RS-232 Built In interface is configured. 

1. Adjust port settings.
2. Select 'Modbus Gateway' from the Mode's drop

down list.

Figure 3-34. RS-485 Serial Port Settings

For the interface being configured, set the port to match
your external system's communication setting. Set the
Unit ID of the Gateway (A), and set the communication
settings Baud Rate (C), Parity (D), and Stop Bits (E).

Setting Description

A Mode of operation

B Baud rate

C Parity

D Stop Bit

014869
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Configuring Modbus Master
See Figure 3-35. The Power Zone Gateway can connect to external systems over RS-485 and RS-232 as a Modbus
Master. This mode of operation is required for SNMP service for the target device, Transfer Switch. Screen for Modbus
Master configuration is identical for the interfaces, shown below is settings on RS-485 interface.

NOTE: SNMP service is configured with the Ethernet Built In interface. See SNMP (Simple Network Management 
Protocol).

Figure 3-35. Serial Port Interface - Modbus Master

Letter Setting Name

A Port Name - port currently being configured

B Mode - Modbus Master currently selected

C Baud Rate - serial port setting (300bps - 115kbps)

D Parity - serial port setting (none, even, odd, mark, space)

E Stop Bit - serial port setting (1,2)

F Add Device - press to add device to communicate with. Up to 30 devices can be added.

G Device Type - (Transfer Switch)

H Device Name - assign friendly name to device

J Modbus Unit ID - id of device added (1-125)

K Modbus Password - password required to communicate with device added

L Remove Device - press to remove device

M Apply Changes- press to have changes take effect, including when removing device

This will change and identify which interface is being configured; RS-232 or RS-485.

014872
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SNMP (Simple Network Management Protocol) 
See Figure 3-37 and Figure 3-40. Navigate to SNMP by
clicking Setup (A), the Communications dropdown (B),
External Interfaces (C), pressing on Configure in Ether-
net Built In section, pressing on Configure in the SNMP
Section. The protocol SNMP is used by NOC (Network
Operations Center) or data center to monitor Power Zone
system.

NOTE: The screens differ depending on whether 
SNMPv2c or SNMPv3 is selected. See Figure 3-37 and 
Figure 3-38 for setup. See Figure 3-39 for SNMPv2C 
and Figure 3-41 for SNMPv3 configuration.

1.  Enable SNMP (D).
2. Set SNMP version to SNMPv2c (E).
3. Check the “Enable Authentication” checkbox (F).
4. Tap “Add Community” button (G).
5. Enter Community Name (J) and set access level

(K).
6. To delete an entry use the trash button on the right

side of the screen (H).
7. If multiple communities are being used, go to step

4 and repeat until all communities are entered.
8. Tap “Apply Changes” button (L) to save all settings.

Figure 3-36. SNMPv2c

Letter Setting Name

A Setup

B Communications Dropdown.

C Select SNMP.

D Enable SNMP.

E Select SNMP version SNMPv2c.

F Enable Authentication.

G Add Community. Multiple Communities can be specified, each with 
their own name and access level.

H Delete entry.

J Community name.

K Access Level (None, Read Only, Read Write).

L Save settings.
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Figure 3-37. Enable SNMP Agent

Figure 3-38. Select SNMP Version

Configure SNMPv2c

Figure 3-39. SNMPv2c

Letter Setting Name

A Function settings.

B Select SNMP Version.

C Select to use authentication; further settings 
available after making selection.

D Save Changes.

014614

014613

D

C B

A

Letter Setting Name

D Shows Security Settings Tab.

E Select SNMP version SNMPv2c.

F Enable Authentication.

G
Add Community. Multiple Communities can 
be specified, each with their own name and 
access level.

H Delete entry.

J Community name.

K Access Level (None, Read Only, Read 
Write).

L Save settings.
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Configure SNMPv3
1. Enable SNMP (D).
2. Set SNMP version to SNMPv3 (E).
3. Tap “Add User” button (F).
4. For each user, enter user name (H), select user

access level from the dropdown list (J), select

authentication level (K) from the dropdown list, and
select the encryption setting from the dropdown
list.

5. To delete a user, use the trash button (G) on the
right side of the screen to delete a user.

6. Tap “Apply Changes” button to save all settings.

Figure 3-40. SNMPv3

Letter Setting Name

A Setup

B Communications Dropdown.

C Select SNMP.

D Enable SNMP.

E Select SNMP version SNMPv3.

F Add user.

G Delete entry.

H User name. Requests will be rejected if message does not include 
matching user name.

J Access Level (None, Read Only, Read Write).

K Authentication Level setting (No authentication, MD5, SHA).

L Encryption setting (No Encryption, 128-bit AES, 256-bit AES-Blumen-
thal, 256-bit AES-Reeder).

M Save settings.

013860

A

B

C

D

E

F

G

H

J

K

L
L



24 Owner’s Manual for Power Zone Gateway on PZ 410

Installation and Operation

Figure 3-41. SNMPv3 

SNMP Notifications

Figure 3-42. SNMP Notifications

1. See Figure 3-42. Select the “Notifications” tab.
2. Tap the checkbox to enable SNMP traps to be set.
3. Select “Send Heartbeat” (D) checkbox to send out

periodic notifications.
4. Select “Send at Power Up” (E) checkbox to send

notifications at startup.
5. Select “Send Alarms and Warnings” (F) checkbox

to send SNMP alarm and warning messages.
6. Select “Send Events” (G) checkbox to send Power

Zone Events.
7. To add notification targets, tap the “Add Notification

Target” tab and enter the corect IP address.
8. To delete a particular notification target, tap the

trash button (K) on the right side of the screen.
9. Tap the “Apply Changes” button (L) to save all

settings.

Letter Setting Name

D Enable SNMP.

E Select SNMP version SNMPv3.

F Add user.

G Delete entry.

H User name. Requests will be rejected if mes-
sage does not include matching user name.

J Access Level (None, Read Only, Read 
Write).

K Authentication Level setting (No authentica-
tion, MD5, SHA).

L
Encryption setting (No Encryption, 128-bit 
AES, 256-bit AES-Blumenthal, 256-bit AES-
Reeder)

M Save settings.

014611
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K

L

Letter Setting Name

A Notifications tab selected.

B Enable SNMP Traps to be sent.

C Notification Options.

D Select to send out periodic message.

E Select to send message at Gateway startup.

F Select to send Power Zone Alarms and Warn-
ings in SNMP messages.

G Select to send Power Zone events in SNMP 
message.

H Add SNMP manager address.

J IP address of SNMP manager.

K Delete notification target entry.

L Apply changes.

014593
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IP Whitelisting
See Figure 3-43. Navigate to IP Whitelisting by clicking Setup (A), the Communications dropdown (B), and IP Whitelis-
ting (C). IP Whitelisting is useful when remote access from devices with specific IP addresses is allowed. The IP
addresses can be specified by either format, individual IP address or range of IP addresses using CIDR notation.

Figure 3-43. IP Whitelisting

013606

A

B

C

D

F

E

G H

K

J

Letter Setting Name

D Enables IP whitelisting. Default setting is Disabled. 
NOTE: Settings added prior to disabling will be preserved.

E Adds a text box to enter IP address. Multiple IP addresses can be specified.

F Deletes the list of IP addresses.

G Example specifying either a single IP address or a range of IP addresses using CIDR 
(Classless Inter-Domain Routing) notation.

H CIDR notation of IP address is automatically expanded and shown here (if applicable).

J Save settings.

K Delete individual entry.
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Email
Power Zone features that use email must have access to
a Simple Mail Transfer Protocol (SMTP) email server.
See Figure 3-44. This screen allows you to set up the
email server and recipient list for alarm, event, and warn-
ing emails. The name or IP address of the server provid-
ing SMTP services is entered in the Host field (A). The
name to be used as the sender of the email is entered in
the From field (B). You can use different names for each
generator to help you identify the source of an email.
Enter the port number being used by the SMTP service in
the Port field (C). Most SMTP servers use port 25. 
Select the desired Transport Layer Security (TLS)
settings (D). Options are:

• Automatic TLS Settings: The connection to the
mail server is started in plain text and TLS is used
if the mail server supports the STARTTLS exten-
sion.

• Always Use TLS: The connection to the mail
server is started in plain text and sends STARTTLS
commands even if the mail server does not adver-
tise support for it. If the server cannot support TLS,
no email will be sent.

• Use SMTP over TLS: TLS will be used when con-
necting to the mail server.    

• Never Use TLS: TLS will not be used to connect to
the mail server or as a STARTTLS connection
upgrade command.

If your SMTP server requires a user ID and password to
send emails, check the Use Authentication box (E), and
enter the required user ID and password in the User-
name and Password fields (F).
The Alarm distribution list is used to enter a list of email
addresses that should receive an email notifying them of
any alarms, warnings, or events that occur. To remove an
address from the list, press the red garbage can icon (G)
to the right of the email address. The Alarms and
Warnings check box (H) should be checked if that
address should receive emails of all alarms and
warnings. The Events check box (I) should be checked if
that address should receive emails of all events. If you
would like the emails to contain an attached data log file
of data logged for a period of time preceding and
following the alarm, warning, or event, check the
Attachments check box (J). Click the Add button (K) to
save your changes.

Figure 3-44. Email Screen

Configuring Modbus Pass Through
See Figure 3-45. The Power Zone Gateway acts as a
gateway for external systems to exchange data with a
Power Zone System using Modbus. The Gateway sup-
ports both Modbus TCP and Modbus RTU over RS-485.
To enable Modbus TCP access, check the box labeled
Modbus TCP.
To enable Modbus RTU access, check the Modbus RTU
checkbox and configure the RS-485 port to match your
external system’s communication settings. To configure
the RS-485 port, set the Unit ID of the Gateway (A),
select the RS-485 port from the Serial Port name (B) and
set the communication settings Baud Rate (C), Parity
(D), and Stop Bits (E).

Figure 3-45. Modbus Pass Through Screen

012227

A

B

C

D

E

F

GH

J

K

I

015203

A
B

C

D

E



Owner’s Manual for Power Zone Gateway on PZ 410 27

Installation and Operation

Tools Menu
See Figure 3-46. The Tools menu displays submenus for
login, configuration file transfer, synchroscope, J1939
CAN bus diagnostics, diagnostics, trending, PLC
manager, and update firmware.

Figure 3-46. Tools Menu

Login Menu
See Figure 3-47. The Login menu provides access to
secured functionality through a user’s security
credentials.

To login:
1. Enter credentials into the input control labeled

“Enter Credentials”, or click the keyboard icon and
enter credentials.

2. Select “Log in”.
3. The system will validate the credentials and, if suc-

cessful, will allow access to the appropriate level of
secured functionality. If the credentials were not
valid a failure message will be shown.

Figure 3-47. Login Menu

Configuration File Transfer Screen
Power Zone generator configuration settings can be

saved as key-value pairs in a text file or read from a pre-
viously saved configuration file and applied to a genera-
tor via the Configuration File Transfer menu, which can
be found by selecting the Tools Menu icon. Configuration
File Transfer has two options. The “Read from Controller”
option (Figure 3-48) reads the current settings from a
Power Zone Main Controller and writes them to an text
configuration file which can be saved to a mobile device
through a browser or saved to a USB drive connected to
the Gateway:

1. Navigate to Tools → Configuration File Transfer →
Read From Controller.

2. Select “Get Configuration” to create an text config-
uration file.

3. Select the “Local” tab to download to a mobile
device through a browser. Select “Download”.

4. Select the “Panel” Tab to save to a USB drive.
Select “Save to USB Drive”.

Figure 3-48. Read from Controller

The “Write to Controller” option (Figure 3-49) takes an
existing text configuration file and applies those settings
to the Main Controller:

1. Navigate to Tools → Configuration File Transfer →
Write to Controller.

2. To use a file stored on your network connected
device, select the “Local” tab and select “Choose”.
Select the file and select “Load”.

3. To use a file stored on a USB device connected to
the Gateway, select the “Panel” tab and select “List
Configuration Files”. Select the file and select
“Load”.

Figure 3-49. Write to Controller

Load the Power Zone Software Package
1. See Figure 3-50. Select “USB on Display” tab (A).
2. Select “Choose” (B).
3. Select a package and select “Load” on the file

uploader.
To upload a package remotely:

1. Select the “Local File” tab (C).
2. Select “Choose” (B) to display search navigation.

014873

009625

009626

009627
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3. Select a package.
4. Select “Load”.

The “Load” button uploads the chosen package to the
Gateway. After the upload is successful, the Gateway will
display a summary of the updates to be made.
Press the “Continue” button (D) after reviewing the ver-
sions of the firmware files from the bundle. The System
Update screen will display the firmware updates to be
made.

Figure 3-50. Load Software Package

See Figure 3-51. Press the “Start” button (E) to begin the
upgrade process. The start button will change to an
“Abort” button (E) which can be used to terminate the
update process. Aborting an update while in progress
can leave some Power Zone modules in a boot loader
mode. To recover, run the System Update process to
completion. During a system update, the Status column
(F) will display the status of each step of the update pro-
cess. If the Gateway is updated, it will automatically
reboot. During reboot the Gateway will lose connection
with other devices, including the PC. The web browser
screen showing the application will time out. After reboot
is complete, the PC web browser will re-establish con-
nection with the Gateway app.

Figure 3-51. Upgrade Progress

HTTPS Configuration Screen
See Figure 3-52. The Gateway comes from the factory
with self-signed SSL/TLS security certificates. The
default certificates can be replaced with domain specific

certificates via the HTTPS Configuration Screen.

To upload certificates from a remote computer:
1. Select the “Local” tab (A) in file uploader.
2. Select “Choose” (B) to open search navigation.
3. After a file is chosen, select “Load” (C) to upload

file.
To upload files from USB:

1. Select the “Panel” tab (D).
2. Select “List Files” to display files found on USB

drive.
3. Select “Load” (C) to upload file.

HTTP access can be enabled and disabled via port 80.
HTTPS on port 443 is always enabled. If HTTP is
disabled, all attempts to access the Gateway via HTTP
port 80 will be routed automatically to HTTPS port 443. If
the “Use user supplied certificate” check box (E) is not
checked, the factory default certificates are used. Once
the certificate files are uploaded, select “Apply Changes”
(F) for the certificates to be used.

Figure 3-52. HTTPS Setup
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Help
The Help menu provides access to the user manuals and
documents, the About screen, and the Upload Docu-
ments screen.

Figure 3-53. Help

About Screen
This screen displays information about the Power Zone
system such as hardware and firmware versions, exter-
nal storage, and the current status of communication
ports.
Press the 'Factory Reset' button to restore the Gateway
to its original system state.
The ability to initiate a Factory Reset or Network Reset is
available on the built-in display. The Factory reset is the
same as what's available on the Gateway Support Tools
menu.

Upload Documents Screen
See Figure 3-54. The Upload Documents screen can be
used to either provide translated Power Zone Owner’s
Manuals or documentation like wiring diagrams for stor-
age and use on the Gateway. Only PDF files are cur-
rently supported.
To select a file from a mobile device:

1. Select “Local File” tab (A).
2. Select “Choose” (B).
3. Select a file from your mobile device.

To select a file from a USB drive attached to the
Gateway:

1. Select “USB on Panel” tab (C).
2. Select “List Packages”.
3. Select a file.

To upload the file as a manual:
1. Select the file and choose the “Manuals” radio

button (D).
2. Select from the “Manual List” dropdown (E).
3. Select the language of the manual (F).
4. Select “Upload file” (G).

To upload the file as a document:
1. Select the file and choose the “Documents” radio

button (H).
2. Select from the “Documents” dropdown, or type a

new document name for the uploaded file.
3. Select the language of the document (F).
4. Select “Upload file” (G).

Figure 3-54. Upload Documents Screen

Login and Security
See Figure 3-55. From the “Tools” menu (A), select
“Login” (B). This screen provides a keyboard to input a
password for access to restricted areas of the app.

NOTE: If not logged in, the user will be prompted to
enter a password if trying to access a restricted area of
the app, as shown in Figure 3-56.

Figure 3-55. Login Menu

Figure 3-56. On-screen Keyboard
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Transfer Switch Dashboard

Figure 3-57. Transfer Switch Dashboard

See Figure 3-57. The Transfer Switch Dashboard
Screen shows the current settings and readings retrieved
from the Transfer Switch Controller. Figure 3-57 shows
three transfer switches connected and details for each
one. For each transfer switch shown, by clicking in a
transfer switches region in the screen, it’s status is shown
along with Exercise and Heater settings that can be
adjusted. See Figure 3-58, Figure 3-59, and Figure 3-
60.

Figure 3-58. Transfer Switch Status

Figure 3-59. Transfer Switch Exercise

Figure 3-60. Transfer Switch Heat and Humidity Settings
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Section 4: Troubleshooting
Troubleshooting Guide

Problem Solution

Red LED in front of 
enclosure is OFF

Verify 12 V  power and ground wires are connected properly on PWR_RS485 connector to 
the Power Zone Pro Main Controller BS6 connector.

Green LED in front 
of enclosure is OFF

Verify the RS-485 wires are connected properly on PWR_RS485 connector to the Power 
Zone 410 Controller.

Green LED in front 
of enclosure is not 
blinking

Operating system or application is not working properly. Unplug and plug back the 
PWR_RS485 cable to the Gateway.
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